This chapter tells how to use the ADM application for local function.

5.1	Opening the Application

To open the application:

1.	Run Windows 95 (or Windows NT 4.0).

2.	Click on Start.

3.	Highlight Programs.

4.	From the Program list, move the highlight bar to Acer ADM Management Console.

From the Advanced Desktop Manager group, click on ADM v2.0 Local Version.

6.	If this is your first time to run the application, you will be prompted to set a login password.  The password prevents unauthorized access to ADM.  Enter your password in the New Password text box.  Your password must contain not exceed eight characters.  

�

Figure 5-1	Set Password Dialog Box

	Type the same password in the Confirm Password text box.  This helps you check whether you have set the correct password.

	If this is not your first time to run the application, the following password prompt appears:

�

Figure 5-2	Password Dialog Box

	Enter your login password in the Password text box.

8.	Click on OK to accept your settings.  Click on Cancel to disregard.

9.	After you click on OK, the ADM v2.0 Local main screen appears on your screen.

�5.2	ADM Local Main Screen

The following figure shows the ADM Local main screen:

�

Figure 5-3	ADM Local Main Screen

By default, the application displays the Basic System Information window.  The Basic System Information window shows information about your system’s hardware and software.  For more details, refer to section 5.2.1.

�5.2.1	Menu Bar

The Menu bar contains the following menus:

File Menu

The File menu includes the following commands:

Change Password

Selecting this command opens the Change Password Dialog Box.  This lets you change your ADM login password.  

Before you change your password, you will be prompted to enter your current login password in the Password dialog box (see Figure 5-2).  After entering your password, the Change Password dialog box appears.  

�

Figure 5-4	Change Password Dialog Box

In the New Password text box, enter your new password.  Enter the same password in the Confirm Password, then click on OK. 

reboot

The Reboot command enables you to restart your system. 

Shutdown

Selecting this command lets you shut down your system.

Exit

This command closes the ADM program window.  

View Menu

The View menu includes the following options:

Toolbar

This option lets you display or hide the toolbar, i.e., the buttons for some of the most common ADM commands that usually appear just below the menu bar.  When the toolbar is displayed, a check mark appears beside the command item.

�

Figure 5-5	Toolbar

�Status Bar

This option lets you display or hide the status bar, i.e., the bar located along the bottom of the ADM program window.  When the status bar is displayed, a check mark appears beside the command item.

�

Figure 5-6	Status Bar

Information bar

This option lets you display or hide the information bar, i.e., the bar located on the left side of the ADM program window that contains buttons.  These buttons allow you to open windows that contain your system’s hardware and software information.  When the information bar is displayed, a check mark appears beside the command item.

�

Figure 5-7	Information Bar

�Information Menu

The Information menu includes the following options:

PC Monitor

Choosing this option opens the PC Monitor window.  This window shows the current condition of your machine based on predefined criteria.

�

Figure 5-8	PC Monitor Window:  Resource Page

Resource Page

GDI (Graphic Device Interface)

Size�Specifies the amount of kernel resources  (in megabytes) allocated for GDI.  ��Free (%)�The percentage of kernel resources available in your system.����The GDI function is not available under Windows NT 4.0.  ��Warning Threshold�Specifies the value that ADM must use as reference to check the GDI resource utilization.  If the percentage of free resources falls below this value, it points to slight irregularities in the system causing ADM to execute predefined actions to inform you of the condition.��Critical Threshold�A specified value lower than the Warning Threshold referred to by ADM to check the GDI resource utilization.  If the percentage of free resources falls below this value, it points to more serious abnormal conditions in the system causing ADM to execute predefined actions to inform you of the status, correct the condition or prevent damage.��Virtual Memory

Size�Specifies the amount of kernel resources (in megabytes) allocated as virtual memory.���Free (%)�The amount of unused virtual memory space in megabytes.���Warning Threshold�Specifies the value that ADM must use as reference to check the virtual memory utilization.  If the percentage of free resources falls below this value, it points to slight irregularities in the system causing ADM to execute predefined actions to inform you of the condition.����

Critical Threshold�A specified value lower than the Warning Threshold referred to by ADM to check the virtual memory utilization.  If the percentage of free resources falls below this value, it points to more serious abnormal conditions in the system causing ADM to execute predefined actions to inform you of the status, correct the condition or prevent damage.����

Figure 5-9	PC Monitor Window:  Storage Page

Storage Page

Drive�Specifies your system’s drive name.��Total Size�Specifies the drive capacity in megabytes.��Free Size�The amount of unused disk space in megabytes.��Warning Threshold (MB)�Specifies the value that ADM must use as reference to check the storage utilization.  If the percentage of free resources falls below this value, it points to slight irregularities in the storage device causing ADM to execute predefined actions to inform you of the condition.��Critical Threshold (MB)�A specified value lower than the Warning Threshold referred to by ADM to check the storage utilization.  If the percentage of free resources falls below this value, it points to more serious abnormal conditions in the storage device causing ADM to execute predefined actions to inform you of the status, correct the condition or prevent damage.���

Figure 5-10	PC Monitor Window:  Fan Page

Fan Page

Type�Specifies the type and function of the fan that is being monitored, e.g., system fan, CPU fan.��Status�Specifies the current status of the fan.  Possible setting may either be Normal or Critical.���

Figure 5-11	PC Monitor Window:  Temperature Page

Temperature Page

Type�Specifies the component that is being monitored.��Status�Specifies the current status of the monitored component.  Possible setting may either be Normal or Critical.����

Figure 5-12	PC Monitor Window:  Voltage Page

Voltage Page

Type�Displays the various voltage levels monitored.��Status�Specifies the current status of the monitored voltage.  Possible setting may either be Normal or Critical.���

Figure 5-13	PC Monitor Window:  ECC Page

ECC Page

Status�Specifies the current status of the ECC function.  Possible setting may either be Normal or Critical.��

�BAsic System Information

Selecting this option opens the Basic System Information window.  This window contains information about your system’s hardware and software.

�

Figure 5-14	Basic System Information Window

Desktop PC

Manufacturer�Shows the manufacturer of your desktop PC.��Product Name�Shows your system’s product name.��Asset Tag�Shows your system’s version number.��Serial No.�Shows your system’s serial number.���System

Computer Name�Shows the name of the PC that you specified.��Network Address�Shows your PC’s Internet Protocol (IP) address.��BIOS

Vendor�Displays the vendor of the BIOS installed in your system.  ��Version�Displays the version information of the BIOS.��Release Date�Displays the release date of the BIOS version. ��Operating System

Name�Shows the currently installed OS.��Version�Shows the OS version information.��Processor

Vendor�Displays the vendor of the processor currently installed in your system. ��Family and Speed�Displays the processor type and speed.��Physical Memory

Total Memory�Specifies the total amount of memory that your system supports.��Maximum Memory Capacity�Specifies the installed memory size.��SIMM Slots No.�Specifies the total number of SIMM slots in your system.��SIMM Slots Used�Specifies the number of occupied SIMM slots.��Basic Hardware Information

Selecting this option opens the Basic Hardware Information window.  This window shows DMI BIOS related data.  When the PC reboots, the DMI BIOS detects your system hardware configuration and keeps these data in a predefined area in the BIOS memory. 

 �

Figure 5-15	Basic Hardware Information Window:  BIOS Page

�BIOS Page

BIOS Vendor�Displays the vendor of the BIOS currently installed in your system.��Version�Displays the version information of the BIOS.��ROM Size�Displays the installed BIOS ROM size, normally 64K.��Release Date�Displays the release date of your PC’s BIOS version.��Starting Address Segment�Displays the installed BIOS starting address, normally 0XF000.��Boot Support�Displays the different boot methods supported by your system BIOS such as Selectable Boot, Boot from CD, or Boot from PCMCIA.��Bus Support�Displays the bus types supported by your system BIOS (ISA, EISA, PCIMCA, �VL-VESA, PCMCIA).��Other Features Support�Displays a list of features supported by the installed BIOS.  From this list, click on the BIOS features that you want to support.��Other Devices�Displays a list of system devices.  From this list, click on the devices that your system supports.��INT 13h Floppy Support�Displays a list of supported floppy drives.  From this list, click on the floppy drives currently installed in your system.���

Figure 5-16	Basic Hardware Information Window:  Baseboard Page

Baseboard Page

Manufacturer�Shows the manufacturer of your system’s baseboard.���Product Name�Shows the baseboard’s product name.���Serial No.�Shows the baseboard’s serial number.���Version�Shows the baseboard’s version number.����

Figure 5-17	Basic Hardware Information Window:  Processor Page

Processor Page

Processor Type�Shows the type of the processor currently installed in your system.��External Clock�Displays the processor’s external clock speed.��Maximum Speed�Displays the maximum speed that the processor can support (in MHz).���Current Speed�Displays the current speed of the processor (in MHz).���Manufacturer�Displays the manufacturer of the CPU installed in your system.���

Processor Upgrade�Describes the possible upgrade method that can be used for upgrading the CPU.���Processor Family�Displays the processor family where your processor belongs.���Version�Displays the processor version.����

Figure 5-18	Basic Hardware Information Window:  Memory Controller Page

Memory Controller Page

Err. Detecting Method�Displays the error detecting method used by your system’s memory controller.��Err. Correcting Capability�Displays the error correction method used by the memory controller.��Interleave Support�Specifies the interleave types supported by the memory controller, i.e.,  Other, Unknown, One Way Interleave, Two Way Interleave, Four Way Interleave, Eight Way Interleave, or Sixteen Way Interleave.��Current Interleave�The interleave type currently supported by the memory controller.��Max. Memory Module Size�Displays the maximum memory size in megabytes that the memory controller supports.��Support Speed�Specifies the memory speed supported by the controller.��Support Type�Specifies the memory module type supported by the controller.��Memory Module Size�Specifies the maximum memory module size that a single memory slot can support.��No. of Associated Memory Slot�Displays the number of memory slots that the memory controller handles.����

Figure 5-19	Basic Hardware Information Window:  Memory Module Page

Memory Module Page

Socket Designation�Specifies the string assigned to the memory socket.��Bank Connection�Specifies the number of SIMM slots per bank.��Current Speed�Specifies the speed of the memory module installed in your system.��Current Type�Displays the physical characteristics of the memory modules installed in your system.���

Installed Size�Displays the total memory size of the modules installed in your system (in megabytes). ��Enable Size�Displays the enabled memory size in megabytes. ��Error Status�Specifies the correctable errors received from the module.���

Figure 5-20	Basic Hardware Information Window:  Cache Page

Cache Page

Socket Designation�Specifies the string assigned to the cache socket.��Max. Size�Displays the maximum cache size supported.��Installed Size�Displays the cache size installed in your system.��Supported SRAM Type�Displays the SRAM types supported by your system.��Current SRAM Type�Specifies the SRAM type currently supported by your system.���

Figure 5-21	Basic Hardware Information Window:  Port Connector Page

Port Connector Page

Internal Reference�Specifies the internal reference string.��Internal Connector Type�Displays the internal connector specification.��External Reference�Specifies the external reference string��External Connector Type�Displays the external connector specification.��Port Type�Describes the function of the port.���

Figure 5-22	Basic Hardware Information Window:  Slot Page

Slot Page

Slot Designation�Specifies the string assigned to the slot.��Type�Displays the slot’s type.��Data Bus Width�Displays the slot’s data bus width.��Current Usage�Displays the slot’s usage status.��Slot Length�Displays the slot’s length.��Slot ID�Specifies the slot whether it is MCA, EISA, PCI, or PCMCIA.��Characteristics�Displays the voltage used and slot sharing, e.g., PCI/ISA.���

Figure 5-23	Basic Hardware Information Window:  Onboard Device Page

Onboard Device Page

Device Type�Specifies the type of device installed in your system, e.g., Video, SCSI, Ethernet, Token Ring, and Sound.��Description�Shows a brief description of the device.��Storage Information

Selecting this option opens the Storage Information window.  This window displays the status of the drives installed in your system, including the external or network mapped drives.

�

Figure 5-24	Storage Information Window:  Physical Disk Page

Physical Disk Page

Disk

Type�Specifies the media type, e.g., CD-ROM, diskette, hard disk.��Index�Displays the index number for each disk type.��

Parameters

Interface Type�The storage interface, e.g., Floppy, IDE, SCSI.��Media Loaded�Checks whether the disk is loaded.  Possible value is either Yes or No.��Removable Drive�Checks whether the disk is removable or fixed.  Possible value is either Yes or No.��Cylinders�Specifies the number of cylinders in the disk.��Sector/Cylinder�Specifies the number of sectors on the disk.��Heads�Specifies the number of heads on the disk.��Bytes/Sector�Specifies the number of bytes per sector.��Total Size�Displays the total disk capacity in kilobytes.��No. of Partitions�Specifies the number of partitions created on the disk.��Physical Location�Indicates where the disk is currently installed.��Partitions

Name�Specifies the disk partition name.��Size�The partition size in kilobytes.��Free Space�Displays the amount of unused disk space in kilobytes.��File System�Specifies the file system that the disk supports.���

Figure 5-25	Storage Information Window:  Logical Disk Page

Logical Disk Page

Drive�Specifies the logical drive’s letter and name.��Type �Displays the logical drive’s media type.��Total Size�Shows the drive capacity in kilobytes.��Free Size�Specifies the amount of available disk space in kilobytes.��System REsource Information

Selecting this option opens the System Resource Information window.  This window displays the resources available in your system.

 �

Figure 5-26	System Resource Window

Device Name�Displays the installed device.��IRQ�Displays the IRQ assigned to the device.��DMA�Displays the DMA channel assigned to the device.��I/O Port�Displays the I/O port occupied by the device.��Memory Address�Displays the base memory occupied by the device.��Manufacturer�Displays the device manufacturer.��I/O Peripheral Information

Selecting this option opens the I/O Peripheral Information window.  This window shows the address, IRQ, port assigned, and specification of the I/O devices present in your system.

 �

Figure 5-27	I/O Device Information Window:  I/O Port Page

I/O Port Page

Name�Specifies the COM/LPT ports available in your system ( such as COMx, and LPTx ).��Address�Displays the base I/O address of the port.��IRQ�Displays the IRQ assigned to the port.��Capability�Displays the distinct feature of the port (Other, Unknown, XT/AT compatible, 16450 compatible, 16550 compatible, 16550A compatible etc.).��Description�More detailed description about the port.����

Figure 5-28	I/O Device Information Window:  Keyboard and Mouse Page

Keyboard and Mouse Page

Keyboard

Type�Displays the type of keyboard currently connected to your system.��Connector Type�Displays the type of keyboard connector supported by your system. ��Layout�Displays the layout type of the keyboard.��Mouse

Manufacturer�Specifies the device manufacturer.��

Interface�Displays the mouse interface type that your system supports.��IRQ�Specifies the IRQ assigned to the mouse device.��Buttons�Displays the number of mouse buttons.��Port Name�Specifies the port currently occupied by the mouse device.��Driver Name�Displays the name of your mouse driver.���

Figure 5-29	I/O Device Information Window:  Video Page

�Video Page

Manufacturer�Displays the manufacturer of the video card currently installed in your system.��Model�Displays your video card model number.��Driver Name�Displays the name of the video driver used.��Driver Version�Specifies the video driver version.��Current Resolution�Displays the currently supported video resolution of your VGA card.��Current Colors�Specifies the currently supported video colors of your VGA card.��Resolutions Supported�Displays the different video resolutions that the video card supports.  This function is NOT supported under Windows NT.���Network Information

Selecting this option opens the Network Information window.  This window shows the current network configuration of your system.

 �

Figure 5-30	Network Information Window

Network Card 

Manufacturer�Displays the manufacturer of the network card currently installed in your system.��Model�Shows the model number of your network card.��Driver Name�Displays the network driver used by your network card.��Driver Version�Displays the network driver version.��Description�Displays a brief description of your  network card.��TCP/IP

TCP/IP Address�Specifies the IP address assigned to your system.��Net Mask�Specifies the subnet mask number assigned to your machine.��Primary Gateway�Displays the IP address of the primary gateway in the LAN to which your system belongs.��DNS Servers 

DNS Server�Specifies the IP address of your Domain Name System (DNS).���Utilization Information

Selecting this option opens the Utilization Information window.  This window shows how your system uses its resources, device and components.

 �

Figure 5-31	Utilization Information Window:  Kernel Page

Kernel Page

Thread Created�Specifies the total number of threads created.��Virtual Machines Created�Specifies the number of virtual machines created.��CPU Utilization (%)�Displays the processor’s percent utilization.���

Figure 5-32	Utilization Information Window:  Memory Manager Page

Memory Manager Page

Allocated Memory�Shows the total amount of memory allocated in your system.��Locked Memory�Shows the amount of memory locked.��Swappable Memory�Shows the number of memory bytes allocated from the swapfile.��Free Memory �Displays the amount of available memory.��Other Memory�Displays the number of memory bytes which are not stored in the swapfile such as disk cache, pages, memory allocated fixed (non-pageable), and memory mapped files.���Disk Cache

Max. Size�Displays the maximum disk cache size supported.��Min. Size�Displays the minimum disk cache size supported.��Current Size�Displays the disk cache size detected by ADM.��Swapfile

Defective�Shows the number of bytes on the swapfile currently in use.��In Use�Shows the number of bytes on the swapfile currently in use.��Size�Shows the swapfile size in bytes.��Paging

Page Discards�Specifies the number of pages discarded per second.��Page Faults�Shows the number of page faults per second.��Page In�Shows the number of page-in operations per second.��Page Out�Shows the number of page-out operations per second.���

Figure 5-33	Utilization Information Window:  File System Page

File System Page

Bytes Read Per Sec.�Specifies the number of bytes read per second from the file system.��Bytes Write Per Sec.�Specifies the number of bytes written per second from the file system.��Reads Per Sec.�Displays the number of read requests made to the file system per second.��Writes Per Sec.�Displays the number of write requests made to the file system per second.���

Figure 5-34	Utilization Information Window:  IPX/SPX Page

IPX/SPX Page

IPX Packet sent/second�Shows the number of IPX packets sent on the network per second.��IPX Packets received/second�Shows the number of IPX packets received from the network per second.��IPX Packets lost/second�Shows the number of IPX packets received from the network that were dropped because nobody on the local system wants them.��SPX Packets sent/second�Specifies the number of SPX packets sent per second.��SPX Packets received/second�Specifies the number of SPX packets received per second.��Open Sockets�Shows the number of open sockets available.��Routing Table Entries�Displays the number of IPX Internetworking routes detected available.��SAP Table Entries�Displays the number of service advertisements detected.���

Figure 5-35	Utilization Information Window:  Mass Storage Page

Mass Storage Page

Total Space�Displays the total storage capacity of your system (in megabytes).��Free Space�Displays the amount of unused storage space in megabytes.��Space Used (%)�Displays a pie chart indicating the percentage of storage space used.��Operating system INformation

Selecting this option opens the Operating System Information window.  This window shows all OS-related data, including the programs and drivers currently present in your system.

 �

Figure 5-36	Operating System Information Window:  Environment Variables Page

Environment Variables Page

This page lists the environment variable settings of your system.

�

Figure 5-37	Operating System Information Window:  Task List Page

Task List Page

Windows Tasks

Task Name�Lists all windows operations currently running in your system.��Type�Specifies the operation type, e.g., 16-bit, 32-bit.��Real Mode Tasks

Task Name�Displays the DOS task name���

Figure 5-38	Operating System Information Window:  Drivers Page

Drivers Page

Driver Name�Lists all drivers currently loaded in your system.��Type�Specifies the driver type, e.g., 16-bit, 32-bit.���Tools Menu

The Tools menu includes the following options:

Event Log 

This option opens the Event Log window.  This window lists all events that occurred in your system, the component from which the event occurred, the occurrence time, and the event ID.

� EMBED PBrush  ���

Figure 5-39	Event Log Command Window

Notification Log

Issued from�Displays the component ID from which the event occurred.  ��Description�Displays a brief description of the event.��Event Time�Displays the time when the event occurred.  ��Event ID�Displays the event ID.��To show the status of the each event that occurred, the following icons are used:

� EMBED Word.Picture.6  ����Normal ����Warning����Critical��System File Editor

Selecting this option opens the System File Editor window that allows you to modify system files in your system.  

�

Figure 5-40	System File Editor Window

The list box on the left displays all system files in your system, while the box on the right displays the contents of the selected system file.

To modify a system file:

1.	From the left list box, select the system file that you want to modify.

2.	Click on the Get File button.  The right box displays the contents of the selected file.

3.	Make the necessary modifications on the file.

4.	After making the modifications, click on the Put File button to save the changes.

��If you close the window without clicking the Put File button, changes will not be saved to the system file.���General Configuration

Selecting this option opens the General Configuration window that allows you to set the access priveleges of the administrator.  

�

Figure 5-41	General Configuration Window

The administrative priveleges offered are as follows:

Administrator can Remotely Configure the System�Allows the administrator to configure your system.��Administrator can Remotely Edit System Files�Allows the adminitrator to modify your system files such as AUTOEXEC.BAT, CONFIG.SYS, WIN.INI, SYSTEM.INI, etc.��Administrator can Remotely Shut Down this System�Allows the administrator to shut down your system.��

Administrator can Remotely Reboot this System�Allows the administrator to restart your system.��Threshold Configuration

Selecting this option opens the General Configuration window.  This window allows you to set the warning and critical threshold levels (i.e., the resource status level that when reached, a warning or a critical message is issued) for your system’s GDI, VM resources and storage.  

�

Figure 5-42	Threshold Configuration Window:  Kernel Page

�Kernel Page

GDI Threshold

Warning Level�Specifies the percentage (from 0 to 100) limit of free GDI resources.  One the percentage falls below the specified value, ADM will execute predefined actions to inform you of the condition.��Critical Level�Specifies the percentage (from 0 to 100) limit of free GDI resources.  Once the percentage falls below the specified value, ADM will execute predefined actions to inform you that your GDI resources have reached the critical level.����The GDI Threshold function is not available under Windows NT 4.0.  ��VM Threshold

Warning Level�Specifies the percentage (from 0 to 100) limit of free virtual memory.  One the percentage falls below the specified value, ADM will execute predefined actions to inform you of the condition.��Critical Level�Specifies the percentage (from 0 to 100) limit of free virtual memory.  Once the percentage falls below the specified value, ADM will execute predefined actions to inform you that your virtual memory is in critical status.����The Critical Level Threshold can not be greater than the Warning Level Threshold.���

Figure 5-43	Threshold Configuration Window:  Storage Page

Storage Page

Drive�Displays your logical drive letter and name.��Total Size (MB)�Displays the drive capacity.��Free Size (MB)�Specifies the amount of unused space on the drive.��Warning Threshold (MB)�Displays your current Warning Threshold setting.��Critical Threshold (MB)�Displays your current Critical Threshold setting.���

Warning Level�Specifies the amount of free memory in megabytes for Warning Level Threshold.  If the amount of free memory falls below this value, ADM will execute predefined actions to inform you of the condition.��Critical Level�Specifies the amount of free memory in megabytes for Critical Level Threshold.  If the amount of free memory falls below this value, ADM will execute predefined actions to inform you of the condition.����The Critical Level Threshold can not be greater than the Warning Level Threshold.��Window Menu

The Window menu includes the following commands:

Cascade 

This command arranges multiple opened windows in an overlapped manner.

Tile

This command arranges multiple opened windows in such a way that all windows appear on the screen.  

arrange Icons

This option arranges the icons for minimized windows at the bottom of the main window.  If there is an open window at the bottom of the main window, some or all of the icons will be placed underneath this window  and therefore, may not be seen on the screen. 

Help Menu

This menu lets you open and display the ADM Help topics.  From this screen, you can view the ADM help information.

5.2.2	Toolbar

The Toolbar is the bar that appears just below the menu bar.  This contains some of the most common ADM commands and these are as follows:

��PC Monitor�Opens the PC Monitor window.  This window shows the current condition of your machine based on predefined criteria (similar to the Information menu’s PC Monitor option - refer to section 5.2.1).  ����Event Log�Opens the Event Log window.  This window lists all events that occurred in your system, the component from which the event occurred, the occurrence time and the event ID (similar to the Tool menu’s Event Log option - refer to section 5.2.1).���

��System File Editor�Opens the System File Editor window that allows you to modify system files in your system (similar to Tool menu’s System File Editor option - refer to section 5.2.1). ����General Configuration�Opens the General Configuration window that allows you to set the access priveleges of the administrator (similar to the Tool menu’s General Configuration option - refer to section 5.2.1).����Threshold Configuration�Opens the General Configuration window.  This window allows you to set the warning and critical threshold levels (i.e., the resource status level that when reached, a warning or a critical message is issued) for your system’s GDI, VM resources and storage (similar to Tool menu’s Threshold Configuration option - refer to section 5.2.1).����Help�Opens the ADM Help file (similar to the Help menu - refer to section 5.2.1).���5.2.3	Information Bar

The Information bar is the bar located on the left side of the ADM program window. Similar to the Toolbar, it also contains buttons that allow you to open windows containing important information regarding the monitored system.  

The following lists the command buttons found on the Information bar:

��Basic System Information�Opens the Basic System Information window.  This window contains information about the your system’s  hardware and software configuration (similar to the Information menu’s Basic System Information option - refer to section 5.2.1).����Basic Hardware Information�Opens the Basic Hardware Information window.  This window shows DMI BIOS related data.  When the PC reboots, the DMI BIOS detects your system’s hardware configuration and keeps these data in a predefined area in the BIOS memory (similar to the Information menu’s Basic Hardware Information  option - refer to section 5.2.1).����Storage Information �Opens the Storage Information window.  This window displays the status of the drives installed in your system, including the external or network mapped drives (similar to the Information menu’s Storage Information option - refer to section 5.2.1)��

��System Resource Information�Opens the System Resource Information window.  This window displays the resources available in your system (similar to the Information menu’s System Resource option - refer to section 5.2.1)����I/O Peripheral Information�Opens the I/O Peripheral Information window.  This window shows the address, IRQ, port assigned, and specification of the I/O devices present in your system (similar to the Information menu’s I/O Peripheral Information option - refer to section 5.2.1).����Network Information�Opens the Network Information window.  This window shows the current network configuration of your system (similar to the Information menu’s Network Information option - refer to section 5.2.1).����Utilization Information�Opens the Utilization Information window.  This window shows how your system uses its resources, device and components (similar to the Information menu’s Utilization Information option - refer to section 5.2.1).����Operating System Information�Opens the Operating System Information window.  This window shows all OS-related data, including the programs and drivers currently present in your system (similar to the Information menu’s Operating System Information option - refer to section 5.2.1).��5.3	Event Monitor Window

After you have installed the ADM Local package, the ADM monitoring function is automatically enabled once you turn on the system.  This monitoring function allows you to check the status of your system devices, with or without enabling the ADM program.  Therefore, once an error is detected from any of your system devices, a window specifying the component where the error occurred, the error description, the occurrence time, and the event ID automatically pops up on the screen.  This window is called as Event Monitor window.

The following figure shows how an Event Monitor window appears on the screen if ADM is not running. 

�

Figure 5-44	Event Monitor Window (ADM Disabled)

If you want to run ADM at once, click on Yes.  If not, click on Cancel to close the window. 

�If ADM is running, the Event Monitor window appears as follows:

�

Figure 5-45	Event Monitor Window (ADM Running)

Click on Cancel to close the window. 

Parameters:

Issued from�Displays the component ID from which the event occurred.  ��Description�Displays a brief description of the event.��Event Time�Displays the time when the event occurred.  ��Event ID�Displays the event ID.��
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